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29 
Installation reference 

In this chapter we walk you through the steps to install 
BowTieXP.  

29.1. Technical specifications 

BowTieXP is a regular desktop application, which runs on the hardware of the end user. It adheres to all Microsoft 
specifications and only requires domain user rights to be run. It has been validated by Microsoft as Windows 7 
Platform Ready. 
 
BowTieXP runs on Windows Vista, Windows 7, Windows 8.0, Windows 8.1 and Windows 10.  
 
Please note that BowTieXP should work correctly on Windows XP, but as Microsoft no longer supports Windows XP, 
we also cannot officially support Windows XP. 
 
BowTieXP adheres to all Microsoft specifications and only requires regular user rights to be run - important for 
corporate network environments. 
 
BowTieXP can be provided as an msi installer for deployment with network tools like Microsoft Systems 
Management Server. 
 
BowTieXP stores information in a file-based compressed XML database. It does NOT require database software to 
be installed. Even large BowTieXP databases typically stay under 1 Megabyte of size. Even if hundreds of BowTieXP 
database versions are stored, storage requirements on a network file share should stay well under 1 Gigabyte. 
 
Configuration information is stored on disk in the user’s profile, in both the local and the roaming part. Some 
system-wide data is stored in the all users profile (Program Data on Windows 7 and above). The registry is used for 
file extension association and protocol handler association. If possible, these are made system wide in HKLM. If 
access to HKLM is denied, the HKCU hive is used. Citrix and Terminal Server environments are supported, but do 
place constraints on the allowed software activation type. 

29.1.1. Supported operating systems 

 Windows Vista (32 and 64 bit) 

 Windows 7 (32 and 64 bit) 

 Windows 8.0 (32 and 64 bit) 

 Windows 8.1 (32 and 64 bit) 

 Windows 10 (32 and 64 bit) 
 
Please note that BowTieXP should work correctly on Windows XP, but as Microsoft no longer supports Windows XP, 
we also cannot list it as supported. 

29.2. Operating system requirements 

Note that if your system is kept up to date using Windows Update it will most probably meet all of these 
requirements except the .NET framework, but they are listed here for completeness. 
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The Microsoft .NET Framework 3.5 SP1 or higher must be installed on the OS. Vista and higher always have the 
framework preinstalled, and also cannot be removed – this prerequisite is thus always fulfilled on these operating 
systems. Windows 8.0 and above will automatically detect the need for version 3.5 and offer to install it. 
 
Supported operating systems are Windows Vista, Windows 7, Windows 8.0, Windows 8.1 and Windows 10.  
 
MDAC 2.71 or higher should be installed; this is required for importing Thesis files. It is very likely that you already 
have a more recent version of MDAC installed on your pc.  
 
You must have at least 1024 Mb of physical memory; 2048 Mb is needed to run BowTieXP comfortably. You must 
have one drive with 200 Mb of free disk space. In general, if your computer meets the Windows recommended 
system requirements, BowTieXP will work. For intensive use more RAM and CPU speed is recommended. 
 
You must have a minimum screen resolution of 1024x768 and a color depth of 16 bits, but considering the graphical 
nature of BowTieXP – the bigger your screen the better. 
 
BowTieXP can interoperate with all Microsoft Word and Excel versions. The supported Visio versions are 2000, 
2002, XP (2003) and 2007. 
 
In order to run, BowTieXP needs to have the .NET Framework 3.5 SP1 installed on your PC. This is discussed in the 
next section. 
 
If you want to use the SharePoint add-on, there are also requirements on your SharePoint server. Please see section 
29.13 for details. 

29.3. The Microsoft .NET Framework 

Windows 7 and later come with the .NET Framework version 3.5 SP1 already installed out of the box or 
will detect the need and install automatically 

29.3.1. What is Microsoft .NET? 

Microsoft .NET is the Microsoft strategy for connecting systems, information, and devices through Web services so 
people can collaborate and communicate more effectively. .NET technology is integrated throughout Microsoft 
products, providing the capability to quickly build, deploy, manage, and use connected, security-enhanced solutions 
through the use of Web services. 
 
Before you can run BowTieXP, your computer must have the Microsoft .NET framework version 3.5 SP1 installed. 
 
Microsoft advises Windows users to install its .NET Framework because of the growing number of framework-
connected applications on the market. Chances are it is already installed, as it is also delivered by Microsoft using 
Windows Update. 
 
Windows 7 and later come with the .NET Framework version 3.5 SP1 already installed out of the box, or will detect 
the need and install automatically. On Windows Vista, you need to do this manually. 

29.3.2. Is the framework already installed? 

You can simply install BowTieXP and try to run it. If the framework is missing, you will be notified and can install it 
then. 

29.3.3. Install the framework from the MS downloads site 

Browse to: 
 
http://www.microsoft.com/en-us/download/details.aspx?id=22  
 
And download and run the installer. 

http://www.microsoft.com/en-us/download/details.aspx?id=22
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29.3.4. Install the framework through Microsoft Windows Update 

Browse to: http://windowsupdate.microsoft.com and choose to update your computer. 
 
Select the .NET Framework 3.5, if it is listed. You will probably find it under recommended updates. 

29.4. Install BowTieXP 

Browse to: 
 
http://www.cgerisk.com/downloads/bowtiexp/ 
 
Download and run the BowTieXP installer (.msi). 
 
Click through the wizard using the next button until the installation is finished. Note that you will need to check the 
checkbox to indicate you agree with the end-user license agreement in order to continue the wizard. 
 
If you don't want to install BowTieXP through the Microsoft Installer (.msi), you can also choose manual installation: 
 

1. Browse the downloads page to find the BowTieXP executable (.exe).  
2. Unzip the zip file you just downloaded. 
3. Copy the executable in any location you want and run BowTieXP from there. 

 

Note: You will need to extract the software from the .zip archive before it will run correctly! If you receive 
an error message please check to see if you have done this. 

29.5.  Activating the software 

When you start BowTieXP for the first time, you are asked for either a trial code or an activation code in the 
following dialog box: 
 

 
Figure 287 - Activation dialog 

 
If you have a valid trial code, you can enter that in the Activation or Trial Code text box, and BowTieXP will run. After 
the trial code expires this dialog box will reappear. Until then, BowTieXP can be used normally without restrictions. 
 
If you have purchased BowTieXP, you will need to obtain a customer activation code to activate BowTieXP. Once 
you install BowTieXP, copy the code displayed in the Current Host ID text box and paste it into an email. We will 
then send you an activation code. After entering this code in the Activation or Trial Code text box BowTieXP will run.  
 
The Current host ID must be emailed to the following email address: 
 

support@cgerisk.com 
 

http://windowsupdate.microsoft.comn/
http://www.cgerisk.com/downloads/bowtiexp/
mailto:support@governors.nl
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29.6. EULA and release notes 

After activating BowTieXP and starting for the first time, you will have to agree to the end-user license agreement. 
Please read this legally binding document carefully, as you cannot use BowTieXP without full agreement. If you 
agree to the terms and conditions in the license agreement, click the ‘I Do Agree’ button to start using BowTieXP. If 
you do not agree, BowTieXP will exit. 
 
Next, the release notes will be displayed. They contain the latest information about BowTieXP, which may have not 
made it into the official documentation. By selecting HelpRelease Notes they can be redisplayed.  

29.7. File extension registration 

 
Figure 288 - File association prompt 

 
BowTieXP automatically tries to keep the file association to .btf files in order. If BowTieXP detects something wrong 
with it, you are prompted if you’d like to restore it. Note that you can check to never be asked again. In that case 
BowTieXP remembers your choice and automatically applies it the next time. 

29.8. BowTieXP site activation  

BowTieXP can be configured to activate all members of a global or universal domain user group. This is known as 
site activation.  
 
This has the following advantages: 

1. Only one code for all users – can be installed along with the application by IT. 
2. IT can reassign licenses by add/removing users from the group. 

 
Site activation has the following disadvantages: 

1. Only activates computers/users which are members of the domain. 
2. IT needs to create and maintain the group of licensed users. 

 
The group must be a global or universal security group. Distribution groups cannot be activated.  
 
The site activation process is as follows: 
 

Choose group to 

activate

Send site id to 

CGE Risk 

Management 

Solutions

Receive activation 

code

Activate 

BowTieXP

 
Figure 289 - Site activation process 

 
First, choose the user group to activate. BowTieXP creates a site id for this group, which must be sent to CGE so they 
can create an activation code for you. After entering this activation code into BowTieXP, it is activated and will run. 
 
Note that the site id can also be retrieved in a different manner, and the codes can also be entered in a different 
manner. These alternate methods for site activation are described below the sections which show you the process 
to follow in the user interface – just keep on reading. 
 
Now we proceed with the steps to take using the user interface: 
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29.8.1. Showing site activation options 

BowTieXP can be configured to activate all members of a global or universal domain user group. This is known as 
site activation. Click the blue link label to show site activation options. 
 

 
Figure 290 - The product activation codes dialog box 

29.8.1.1. When starting BowTieXP 

Double-click the BowTieXP icon on the desktop. When the activation dialog is shown, click the blue label marked 
“Click here to show site licensing options also”. 

29.8.1.2. When BowTieXP has already been started 

Go to the Help menu and click the “product activation codes” option. When the activation dialog is shown, click the 
blue label marked “Click here to show site licensing options also”. 

29.8.2. Choosing a group to activate 

The computer administration department must create a dedicated group to hold all the users which are licensed to 
use BowTieXP. By doing this it is easy to reassign licenses between users. 
 
Choose this group from the drop-down: 

 
Figure 291 - Choosing the group to activate 

 

29.8.3. Sending the site id to CGE 

After selecting the user group to activate, the site id for the selected group is shown. 

 
Figure 292 - The group to activate has been chosen 
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The “selected site id” should be sent to CGE so an activation code can be generated.  

29.8.4. Entering the activation code 

After receiving the activation code, it can be entered into the dialog to activate BowTieXP. 
 

 
Figure 293 - BowTieXP with a valid site activation code 

 
Note that you must be a member of the intended group for this to function; otherwise access to the software will 
be denied and the newly entered activation code will not be saved. 
 
Also note that after changing group memberships, users will need to log off and on again for these membership 
changes to take effect. Also, changes made on the server can take several hours to take effect. This is because 
active directory servers synchronize their changes on a schedule. The default schedule for synchronization is two 
hours. 

29.8.5. Getting the site id in an alternate manner 

Sometimes the user interface can be a bit of a bothersome manner to retrieve the site id and enter the activation 
code. This will especially be the case when a very large number of groups exist in your network. In this case it can be 
easier to use a different way to retrieve the necessary information. 
 
Internally, BowTieXP uses the SID (Security Identifier) of the group you want to activate to lock itself to. Using the 
GUI, all that is happening is you are presented with a nice manner in which to choose a group and send us the SID. 
 
Another way to give CGE the group security identifier to generate an activation code for is by means of the 
command line, by using the wmic tool, which is built into windows: 
 

 
 
Open a command prompt and issue the following command: 
 

wmic group where name='BowTieXPUsers' get sid 
 
Where you replace BowTieXPUsers with your own group name. Please mail the output to CGE Risk. 
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29.8.6. Saving activation information in an alternate manner 

29.8.6.1. Old style activation.dat 

After successfully starting BowTieXP with a valid key, a file called activation.dat is saved in the user’s profile. This file 
can be copied next to the bowtie.exe executable and BowTieXP will also find it and use it.  
 
If you are deploying BowTieXP on a network, the easiest way to activate it for all users is to place this file next to the 
executable.  
 
When sending the site code / SID to CGE for key generation, you can always request us to supply you with such a 
file. 
 
You can also make then yourself; it is a simple xml file with the following contents: 
 
<?xml version="1.0" encoding="utf-8" standalone="yes"?> 

<ActivationSettings> 

 <ActivationConfigFileFormatVersion>1.0.0.0</ActivationConfigFileFormatVersion> 

 <HostID> </HostID> 

 <ActivationCode>12345678 ABCDEFGH </ActivationCode> 

</ActivationSettings> 

 
Between the tags, you can see “12346578 ABCDEFGH” – this is where the activation code goes.  
 
NOTE: Please read section 29.8.7, How to manage multiple editions of BowTieXP on page 232 about managing 
multiple codes and the behavior BowTieXP has when multiple codes are encountered. 

29.8.6.2. New style activation.dat 

For convenience at large site installations, we have added another file format for activation.dat files which allows 
multiple codes per file and allows you to add comments as well. 
 
Here’s an example file: 
 
; BowTieXP activation codes for our site: 

12345678 ABCDEFGH  ; Advanced BowTieXP License for DOMAIN 

12345678 ABCDEFGH  ‘ Another license 

 

; Now some licenses: 

 

12345678 ABCDEFGH 

 
Each line can be blank or contain an activation code and/or a comment. Activation codes and comments are 
separated by a semicolon character.  

29.8.7. How to manage multiple editions of BowTieXP 

There are multiple editions of BowTieXP: 

 BowTieXP Standard Edition (for regular users) 

 BowTieXP Advanced Edition (contains many advanced features) 

 BowTieXP [Advanced] Navigator Edition (used by data consumers) 

 BowTieXP and IncidentXP (Allows Incident Analysis) 

 SharePoint add-on 

 Spreadsheets add-on 

 etc 
 
All editions are run using the same executable. The activation code signals what edition will be started. 
 
Each edition of BowTieXP can be activated for a specific Domain User Group. It is often easiest to create a specific 
Domain User Group for each BowTieXP edition that will be used.  
 
For example: 

 ‘BowTieXPUsers’ 
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 ‘BowTieXPAdvancedUsers’ 
 
After creating a new user group, an activation.dat file can be generated based on the group SID.  
 
Multiple activation files can be placed next to the executable. Each activation file’s filename should start with the 
string “activation” should have a “.dat” file extension. For example: 
 
CORRECT 

 Activation-Std.dat 

 Activation-Adv.dat 

 Activation-Nav.dat 
 
INCORRECT 

 Activation-Std.txt 

 Std-Activation.dat 
 
Note that the first file found which activates BowTieXP will be the file that gets used – BowTieXP will not keep 
searching for a “better” license, so it is up to you to ensure that the “best” license is tried first by giving it a filename 
which is alphabetically earlier than the other license files.  
 
When using the new style activation.dat files you should place the “best” license codes first in the file – they are 
tried first.  

29.9. Large scale deployment 

BowTieXP/IncidentXP has been regularly deployed on large world wide scale (hundreds of installs) without 
problems.  
 
Deployment of the software consists of two parts: 

 Installation 

 Activation 

29.9.1. Installation 

The installation of the software is very simple – it consists of a single executable file (.exe) without external 
dependencies apart from the .NET framework.  
 
During training sessions, we distribute the software on USB stick. This works as admin rights are not required to run 
the software. It runs straight of the USB stick. If the user so prefers, he can copy the software onto his desktop and 
it will run from there. 
 
For actual installation we also offer an msi which does a minimal set of actions: 

 Copy the exe to the program files folder 

 Add a start menu entry 

 Add a desktop shortcut 

 Registers itself in the “add & remove programs” control panel applet. 
File extension registration is done on start of the software. 
 
This msi is easily scripted by means of msiexec or by capturing the changes to the system. A sample script is 
included below. 

29.9.2. Activation 

After getting the exe onto the system, the software has to be activated.  
 
For large scale deployments, group activation is advised. All the licensed users are made members of a dedicated 
AD global or universal group. The SID (globally unique numerical group ID) of the group is the basis for an activation 
key which allows everybody who is a member of that group to run the software. 
 
This key can be deployed along with the software in the scripted installation. If placed within a text file called 
“activation.dat”, and placed besides the exe, it will be automatically picked up. 
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Group activation also has the advantage of allowing the customer to do license reassignment without our 
intervention – just substitute the user in the group. 

29.9.3. Sample installation script 

Below is a sample installation script (usable in software such as SCCM / SMS), which also copies the activation key 
into the correct directory: 
 
 
msiexec.exe /i "%~dp0BowTieXP-6.0.7.msi" /qb 
  
REM Detect OS version 
if exist "C:\Windows\SysWOW64" ( 
  goto 32_64bit 
) else ( 
  goto 32bitonly 
) 
  
:32_64bit 
Echo. 
copy "%~dp0activation.dat" "C:\Program Files (x86)\BowTieXP\activation.dat" /y 
goto End 
  
:32bitonly 
Echo. 
copy "%~dp0activation.dat" "C:\Program Files\BowTieXP\activation.dat" /y 
goto End 
  
:End 

29.10. Plugin installation 

BowTieXP has support for plugins. Plugins are small pieces of computer code which extend BowTieXP with custom 
functionality, allowing CGE to add customer functionality (as long as it falls within the possibilities offered by the 
plugin architecture / interface. 
 
One example of a plugin is our LOPA plugin, which extends BowTieXP with on-the-fly LOPA calculations on the 
bowties. See our LOPA plugin manual for more details.  
 
Plugins are delivered in files with a “.dll” extension, and are installed by placing them on your system in a place 
where BowTieXP can find them – namely in a folder named “plugins”, next to the main BowTieXP program file 
called “bowtie.exe”. Here is what that looks like in an explorer window: 
 

 
 
To install a plugin we take the following steps: 
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 Download the plugin from our web site. It will usually be inside a zip file along with documentation. 

 Locate your bowtie.exe file – usually in the path indicated in the screenshot: 
C:\Program Files (x86)\BowTieXP\ 

 Make a new folder called “Plugins” next to it 

 Extract the dll file from the download and place it inside the plugins folder. 

 Done! 
 

Note: Plugins cannot be loaded from a network drive. If you are running BowTieXP from a network drive, 
plugins will not load. Install BowTieXP onto your hard disk if you want to use plugins. 

29.11. Plugin activation 

Some plugins require an activation code, just like BowTieXP. The process is the same, except that you can have 
multiple activation codes for multiple plugins. Please note that plugins have the same host and site ids as BowTieXP. 
Make sure to send it along when you request your plugin activation code. 
 
To add a new plugin activation code: 

1. Navigate in the menu bar to Help -> Plugin Activation Codes. 
2. Click on the green plus button to add a new plugin activation code. 
3. From here on this will be familiar – almost identical to regular BowTieXP activation. 
4. Enter the activation or trial code, and click OK. 
5. If the code was valid, it is added and the plugin will run. 

 

 
 

29.11.1. Plugin activation for group locked codes 

If you are doing a group locked activation, and want to deploy codes by means of a dat file, you can do the same for 
plugins. Please request your plugin activation code in a dat file from us, and we’ll supply one. This dat file will be 
picked up when placed next to the bowtie.exe executable, just like for regular activation codes. The name of this dat 
file must match the “pluginactivation*.dat” pattern. 

29.12. Activation file search locations 

BowTieXP searches for activation files in the following locations: 
 
Program data:  %PROGRAMDATA%\Governors\BowTieXP\activation.dat 
User profile local app data: %LOCALAPPDATA%\Governors\BowTieXP\activation.dat 
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Next to the executable: Wildcard pattern activation*.dat 
 

29.13. SharePoint Server Requirements 

If you want to use the SharePoint integration in BowTieXP, there are requirements on your SharePoint server. They 
are described here. 

29.13.1. Basic settings 

BowTieXP files in SharePoint document libraries are the primary means of integration between BowTieXP-related 
products and SharePoint.  
 
The “Team Collaboration Lists” and “Remote Interfaces” settings described below apply to all forms of integration 
between BowTieXP solutions and SharePoint. 

29.13.1.1. Team Collaboration Lists 

As BowTieXP and related products make heavy use of SharePoint document libraries, make sure that the “Team 
Collaborations Lists” feature is activated on site level. 
 

 
Figure 294: Activating the Team Collaboration Lists feature 

29.13.1.2. Remote Interfaces 

The BowTieXP SharePoint solutions use either the SOAP web services. These can be configured per Permission Level 
in the Site Settings, by following these steps: 

1. Go to Site settings 
2. Click Site Permissions 
3. Click Permission Levels 
4. For each of the levels you want to give access, make sure the “Use Remote interfaces” checkbox is 

checked (see the figure, under the Site Permissions header). 
 
BowTieXP supports SharePoint versions 2007 and higher. It uses the SharePoint web services listed in the table 
below to communicate with SharePoint. Furthermore, it requires FrontPage Server Extensions to be running on the 
server.  
 
All of these are enabled by default on a SharePoint Foundation (and higher) installation. 

 
Web service Path 

Authentication …/_vti_bin/Authentication.asmx 

Document workspace …/_vti_bin/Dws.asmx 

Lists …/_vti_bin/Lists.asmx 

People …/_vti_bin/People.asmx 

SiteData …/_vti_bin/SiteData.asmx 

Users and Groups …/_vti_bin/UserGroup.asmx 

Versions …/_vti_bin/Versions.asmx 

Webs …/_vti_bin/Webs.asmx 
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30 
Frequently asked questions 

30.1. General questions 

30.1.1. Q: Can I be kept up to date about new releases? 

Yes, just send an email to bowtiexp-releases-join@governorsmansion.nl  to subscribe to the mailing list. 

30.2. Installation questions 

30.2.1. Q: Can I Install and run BowTieXP on Apple Mac (OSX)? 

The BowTieXP software is built for the Microsoft Windows operating system. Unfortunately, BowTieXP is not Apple 
Mac (OSX) compatible. Macs nowadays do have the ability to run Windows software on them. There are two main 
ways to go about that: 
 

1. Actually install Microsoft Windows on your Mac using Boot Camp. You can switch between Windows and 
OSX, but it requires rebooting.  
(https://www.apple.com/support/bootcamp/) 

 
2. Emulate Microsoft Windows via a program such as Parallels.  

(https://www.parallels.com/eu/products/desktop/). 
 
Our advice is to run BowTieXP on the Microsoft Windows operating system (not emulated) as we support this 
option and it works best, but we have seen clients successfully use BowTieXP on their Mac by emulating Windows 
using products such as parallels. 
If cross platform support and device support is of interest to you, you might want to make your bowties easily 
accessible for viewing by (all) the employees in your organization by using our web viewer – a part of BowTieServer. 
The web viewer (for viewing only, not editing) is independent of operating system, as it is a web solution which runs 
on your browser. Therefore, it runs on Microsoft Windows, Apple Mac OSX, but also your iPads 

30.2.2. Can I install BowTieXP on a server? 

That depend Q: s on what is meant exactly – see the questions below regarding network shares and Terminal Server 
/ Citrix. 

30.2.3. Q: Can BowTieXP run off a network share? 

Yes, provided the client computers are running Windows Vista or Higher. If the clients are running Windows XP, a 
change has to be made to the .NET security configuration. 

30.2.4. Q: Can BowTieXP run under Terminal Server or Citrix Server? 

Yes, BowTieXP is fully compatible with Terminal Server and we have reports from customers it runs flawlessly on 
Citrix. You will need a group locked activation – host locked activation is not supported in this scenario. 

30.2.5. Q: Does BowTieXP support virtualization? 

This depends on what is meant with virtualization: 

mailto:bowtiexp-releases-join@governorsmansion.nl
https://www.apple.com/support/bootcamp/
https://www.parallels.com/eu/products/desktop/
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 If with virtualization you mean running the software on a remote server and showing the app via the 

network (also known as desktop virtualization/VDI), then the answer is yes –for Microsoft Terminal 

Server.  See the questions about Terminal Server and Citrix. 

 

 If virtualization refers to portable application generators like Spoon studio or VMware ThinApp, the 

answer is no, but this does not mean it will not work – just that we cannot support that scenario. Should 

any issues present, we will of course try to resolve those but we cannot guarantee we can – some of 

those applications do some very complex things to the software. We know, we used some of those tools 

for previous BowTieXP versions. 

30.2.6. Q: What rights/access does BowTieXP need on the computer to run / can 
BowTieXP be used in a no-touch deployment situation / is a portable version 
available?  

BowTieXP requires only regular user rights to function. BowTieXP adheres to the Microsoft standards about where 
to store data. In practice this means: 
 
Configuration files are stored in the user’s application profile (in %APPDATA%\Governors\BowTieXP).  
 
Activation data is stored in the local part of the profile (%LOCALAPPDATA%\Governors\BowTieXP). 
 
If BowTieXP has admin rights it will store activation data in the all users profile / application data path 
(%ALLUSERSPROFILE%\Governors\BowTieXP). 
 
If allowed, a registry entry will be added to HKCR for the file association and protocol handler. The association is 
stored in HKLM if allowed, else in HKCU. 

30.2.7. Q: How can I deploy activation keys along with the application / when 
scripting the application? 

You can place the codes in a text file names activationcodes.dat and place that next to the exe. They will be picked 
up automatically.  Note that all files which start with activation and end with .dat are considered 
(activation*.dat). The first working code which is found is used. 
 
Activation codes for plugins can also be placed next to the exe. The files must conform to the 
pluginactivation*.dat search pattern. 
 
You can copy the plugin activation codes file (“pluginactivation.dat”) from one of the below folders and copy it next 
to the exe: 

 %PROGRAMDATA%\Governors\BowTieXP\pluginactivation.dat or  

 %APPDATA%\Governors\BowTieXP\pluginactivation.dat 
That ensures the correct format. 

30.2.8. Q: Activating all the licenses we bought one computer at a time is too much 
work. Is there an alternative? 

Yes – if your computers are domain computers you can activate the software by making the users members of a 
dedicated active directory group.  
 
The group has to be a global or universal security group. A code is generated for this group. The code works for all 
members of that group.  
 
The code contains a maximum number of users. If there are more users in the group than the maximum, the 
software will not run. 
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30.2.9. Q: Group locked - if I change the number of licensed users or the type of 
license, do I need to update each computer? 

Yes - if you purchase additional licenses, you will be issued a new activation code. This code has to be deployed to 
each computer where BowTieXP is installed. This can be done by IT updating the scripted installation package or by 
mailing the users so they can enter the new code manually. 
 
This is a result of having a licensing mechanism without a central server. Not having a central licensing server has 
advantages and disadvantages. Having to deploy new codes is a disadvantage as it takes more work. Not having to 
install a license server, adjusting firewalls, and having trouble with people going off the network is an advantage.  

30.2.10. Q: What are the steps to create this group-locked activation code? 

This is also covered in-depth in our software manual.  
Short list of steps: 

1. Create group in AD 

2. Make all licensed users members of this group 

3. Send group SID or site id to us 

4. We respond with an activation key 

Here are the detailed instructions for doing so: 
 

1. Create a user group in Active Directory to hold the licensed accounts: e.g. "BowTieXPUsers". This can be 
done on a domain controller using the “Active Directory Users and Computers” MMC applet.  

 
2. Add all the user accounts which will be licensed into the group.  

 
3. We will need the group SID/site id (internal numerical group code) in order to calculate an activation code 

for this group. We will store this code into a small text file called activation.dat, which must be placed next 
to the BowTieXP executable so it can be found.  

 
The next step is retrieving this SID/site id. This can be done via BowTieXP, unless the number of groups on 
the server is very large. Then we recommend using the command line.  

 
A. Via BowTieXP: Start BowTieXP. The activation dialog will appear. If not, go to Help->Activation Codes. Click 

the blue link to show site licensing options also. Select the BowTieXPUsers group from the drop down. 
Send the site id to us. 

 
B. Via the command line. Open up the command line and issue the following command for your own 

BowTieXP users group: 
 

wmic group where name='BowTieXPUsers' get sid 
 

and mail the SID (S-1-5-21-....) back to us.  
 

4. After receiving the code, we will create an unlock code for you and send this back in a small text file, 
called activation.dat, which must be placed next to the BowTieXP executable. After this, all members in 
the group should be able to run BowTieXP. 

 
Tips for testing:  

 Make sure the test user is actually a member of the group (this is often forgotten), 

 Group membership changes take effect after log-off and log-on.  

30.2.11. Q: Will group activation still function if my computer is without network 
access for a long period of time? 

Yes. 
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30.2.12. Q: I am testing BowTieXP group activation but I get the following error: 
“Activation code does not match any of the current user’s group 
memberships”. 

Ensure the current user is a member of the activated group. You can verify this by letting BowTieXP show you the 
current user’s group membership. 

30.2.13. Q: The user is added to the group in active directory, but BowTieXP does not 
pick up this change. 

There are several reasons why the change might not have taken effect yet: 

 Active directory servers need to sync before changes are applied. The default schedule is two hours. Wait 

at least this long and try again, or ask the AD admins to force a sync. 

 The group membership info for the current user is only updated when logging on. Please log off and back 

on again to update the user’s group memberships (the security ‘token’). 

 If the activated group is a distribution group BowTieXP will not see it. Ensure it is a security group. You can 

double check this in AD users and computers by viewing the group properties. Security groups are the 

default group type. 

30.2.14. Q: Activation error: Activation code does not match the activated or current 
host id. 

Before you entered the activation key, the hardware was changed. Perhaps a laptop docking station was attached 
or detached.  
Solutions: 

1. Restore the original hardware situation. You need to close and open BowTieXP after changing this. 

a. If the docking station is connected, unplug the docking station and try again.  

b. If it is disconnected, try connecting it.  

2. If that does not work: Select “lock to this computer with an old host id”.  

a. If the box is empty: enter the original host id sent to us in the activated host id box.  

b. If it is not empty: Try clearing it. 

3. If both fail: Contact us for a new key. 

30.2.15. Q: How can I script the installation? 

The msi can be with the regular command line options: 
 

 msiexec.exe /i <msifile> /qb 
 
 If you want to also deploy the dat license file you might need to capture changes to create a deployment script, or 
manually make sure the dat file is placed next to the exe. Another option is for end-users to enter it manually. Note 
that BowTieXP has no dependencies other than having the framework 3.5 SP1 or higher installed. Deployment is 
xcopy deployment; all the msi does is: 

1. Copy the bowtie.exe file to C:\Program Files\BowTieXP\ 

2.  Add a shortcut to the start menu and the desktop. 

A sample script could look like this: 
 

msiexec.exe /i "%~dp0bowtiexp-5.0.8.msi" /qb 
copy "%~dp0activation.dat" "C:\Program Files\BowTieXP\activation.dat" /y 

 
The variable %0 in a batch script is set to the name of the executing batch file. The ~dp special syntax between the % 
and the 0 basically says to expand the variable %0 to show the drive letter and path, which gives you the current 
directory containing the batch file. 
 
Note: This sample does not know the difference between 32 bit and 64 bit systems so you might want to take that 
into account (i.e. copy file to the ”Program Files (x86)” folder instead of to the regular ”Program Files” 
folder). 
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30.2.16. Q: What prerequisites / dependencies does BowTieXP have? 

BowTieXP requires the .NET Framework 3.5 SP1 or higher to be installed. Windows 7 and later come with the .NET 
Framework version 3.5 SP1 already installed out of the box, or will detect the need and install automatically. On 
Windows Vista, you need to do this manually. 
 
In Windows XP and Vista you will need to install the framework if not yet installed. 
 
See here for an overview: 
http://blogs.msdn.com/b/pmarcu/archive/2010/02/05/which-version-of-net-is-built-into-windows.aspx  
 
If you want to use the import from Thesis function you will need MDAC 2.71 or higher. If you are running Vista or 
higher this should already be present on your system. 
 
In Windows XP there’s a tiny chance you might have to update the component. 
 
Microsoft MDAC FAQ: 
http://msdn.microsoft.com/en-us/library/windows/desktop/ms692877%28v=vs.85%29.aspx  

30.2.17. Q: Can I deploy templates along with the software? 

Yes, just place the btf files in a directory called ”Templates” located next to the executable. They will be 
automatically picked up and built-in templates will be automatically hidden. 

30.2.18. Q: Can I install mutiple versions side by side? I need to support files which 
must stay in an old file format. 

Some people, for example consultants, need to run different versions of BowTieXP side by side in order to keep files 
in the file format their clients use. We have made sure that you can run different versions side by side, and from 
version 3.6.4 and onwards, we have added some more support in the software for this scenario: you can view the 
version in which a file was last saved. 
 
To view in which version a file was last saved, open it in BowTieXP and choose File->Properties. 

 
For example, assume we see that the file was written using a 3.6 version. Since all 3.6 versions share the same file 
format, we can edit this file using the latest 3.6 version and send it back to the person we got it from, and they will 
be able to read it without having to upgrade to the latest version. 
 
In order to run different versions of BowTieXP side by side, all we have to do is to download the different versions 
we want and make sure to grab the versions for manual installation (the zip files).  
 
All BowTieXP versions needed to support every file format version ever released, are available on the download 
page located at http://www.cgerisk.com/downloads/bowtiexp/index-all.php.  
 
Let’s show by means of an example (the 2.3.0 file) how to install the correct version. We need BowTieXP 2.3.0 to 
edit this file without upgrading the file format. Go to the download page and locate 2.3.0. 
 
Download the executable (“in a zip file, for manual installation”). This zip file contains the bowtie.exe version 2.3.0. 
Unzip it to a suitable location, such as your desktop. You probably want to rename it to reflect the version number. 
 
After starting the older BowTieXP version, you might be confronted with an activation dialog. Contact us for an 
older key – we can put this into a small file called activation.dat which is automatically picked up by BowTieXP, so 
you do not need to enter the key manually. Just make sure the file is located next to the executable. 

30.2.19. Q: How does the auto update work?  

The behavior of the auto-update depends on the way in which BowTieXP was installed.  
BowTieXP can be installed in two ways: 

1. Via the msi 

2. By placing the exe somewhere on the system  

http://blogs.msdn.com/b/pmarcu/archive/2010/02/05/which-version-of-net-is-built-into-windows.aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/ms692877%28v=vs.85%29.aspx
http://www.cgerisk.com/downloads/bowtiexp/index-all.php
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If an update is available, the following will happen if the user requests it / clicks the notification: 
 
In the first case (msi installed), BowTieXP will download the msi and ask windows to install it, upgrading the old 
installation. Windows will ask for admin credentials if the current user is not an administrator. 
 
In the second case (installed from zip file), BowTieXP will download the new exe and replace the current one. If the 
user has no write access to the exe no attempt will be made (i.e. the update check is notification only, auto-upgrade 
is not possible). 

30.2.20. Q: How can I disable the auto-update? 

To disable the auto-update, the read-only bit on the file can be set. This will disable all upgrade functionality. In this 
case the software will still check for updates (if requested or if the periodic check is enabled), but it will only be a 
notification, no attempt at auto-upgrading is done. 

30.2.21. Q: How often are updates and upgrades released? What is your release 
schedule? 

BowTieXP has regular updates, addressing bugs. These versions are recognizable by having the same first two 
numbers but a new third number. E.g. if you have 5.2.2, then version 5.2.3 will have the exact same functionality 
but less bugs. The same goes for versions 5.2.4, 5.2.5 etc. 
 
Once or twice per year we also bring out a new version with new functionality. The version with new functionality 
will have a new file format to accommodate the new features. To indicate this, we change the first and/or second 
version numbers. E.g. we go from 5.0 to 5.2. 
 
If keeping up with the new versions is a challenge, it is advisable to pick a version to stay with for a longer time. Only 
when users are running into bugs or if critical bugs are discovered and fixed, should a new version with fixes be 
deployed. To prevent this, it is advisable to wait a while when a new version with new functionality is released 
before deploying it, allowing more time for bugs to be fixed before that version is deployed. 

30.2.22. Q: I get an exception about “no more files” on startup when trying to run 
BowTieXP deployed/virtualized with App-V 

We have seen this problem when during scripting, one of the directories used by BowTieXP was monitored and 
should have been excluded. In that case the directory which should have been excluded was: 
 

%APPDATA%\Governors\BowTieXP\Backups 
 
After excluding this directory, the software worked correctly. See here for someone with a similar problem, but for 
a different software product (not related to us): 
 
http://www.danieletosatto.com/2010/09/09/fix-rssowl-virtualized-with-microsoft-app-v-fails-to-launch-after-the-
first-attempt/  

30.2.23. Q: Plugins do not seem to load, but are placed in the right location. 

Please check to see if you are running BowTieXP from a network location. Plugins can only be loaded from the local 
hard disk, not from a network drive. 

30.3. Q: Software questions 

30.3.1. Q: Can I convert diagrams to pdf? 

Yes – either copy the diagram to the clipboard, paste in Word/Excel/Visio 2007 or higher. You can save the file as a 
pdf from Office. 
 
Another option is to print to a pdf printer, but in our experience the Office route offers better image quality. 

http://www.danieletosatto.com/2010/09/09/fix-rssowl-virtualized-with-microsoft-app-v-fails-to-launch-after-the-first-attempt/
http://www.danieletosatto.com/2010/09/09/fix-rssowl-virtualized-with-microsoft-app-v-fails-to-launch-after-the-first-attempt/
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30.3.2. Q: Which Office versions does BowTieXP support? 

We support all office versions higher than Office 2000.  

30.3.3. Q: Which Visio versions does BowTieXP support? 

We support Visio 2002 and higher. See paragraph 13.4 for Visio diagram exporting details. 

30.3.4. Q: Can I save files to an older file format? 

This is unfortunately not possible. You might be able to convert a file back to an older version by means of the scrap 
book – the scrap book has somewhat better forward compatibility due to the fact that the scrapbook exchange file 
format is being kept as constant as possible.  
 
Unfortunately, after the introduction of BowTieServer some scrapbook file format changes had to be made. 
Introducing a new file format always leads to the situation where “old” versions of the software will not be able to 
read the “new” scrap book file format. The “old” scrap book format is supported up to versions 6.2.6 of BowTieXP. 
The new scrap book exchange format was introduced in version 6.2.7 of BowTieXP. 
 

Note: be sure to use the latest version of the target version (i.e. if you need to convert to file format 4.2, 
be sure to use the latest 4.2 version in this case 4.2.9). 

 
For example, here are the steps to take to down-convert a file from v5.2 to v5.0 

1. Open 5.2 and 5.0 side by side and ensure you are running BowTieXP Advanced. Ensure the scrapbook is 

visible in both. Open 5.2 on the left, 5.0 on the right. 

2. Open the file to convert in 5.2. Create a new file in 5.0 on the right. Empty ALL the lookup table entries in 

the destination file. 

How to move items from 5.2 on the left to 5.0 on the right: 
a. Drag items from the tree view onto the scrapbook in 5.2 (left) onto the scrapbook. Save the 

scrapbook. In 5.0 on the right, click the load scrapbook button and open the file. 

b. Drag the items in 5.0 (right) to the correct bowtie group in the tree view. 

Note: this mini guide is not verified for completeness / i.e. it might not be an exhaustive list! 

 

3. Transfer the contents of all lookup tables, starting from the top and working your way down. Include 

activities, document links, etc. 

4. Manually recreate the risk matrices. This has to be done by hand. 

a. Recreate the categories. 

b. Recreate the matrices themselves. 

c. Use the copy matrix function where possible. 

5. Terminology. Export the terminology from 5.2 to Excel. Try to import in 5.0. Errors will be given, fix each 

by hand and try until it succeeds. Fixing involves removing lines of terminology which 5.0 does not 

understand. 

6. Transfer all incidents and bowtie groups using the scrapbook. This is done in the same manner as the 

lookups. 

7. Save the spreadsheet if any. Load into 5.0. Check for moved columns and adjust accordingly until the 

calculations are in order again. 

8. Verify completeness using the case file compare function. 

9. Check the following and transfer manually if needed: 

a. Null value descriptions and colors. 

b. File property fields (File->Properties). 

c. Treeview filter profiles. 

d. Treeview tooltips. 

e. Diagram display profiles. 

f. Verify font settings. 

g. Header and footer layout. 
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Now most items should be transferred.  

30.4. Q: Software problems 

30.4.1. Q: Printing does not work/crashes. 

There are some incompatibilities between .NET and some printer drivers, which unfortunately we can do nothing 
about. If printing does not work for you, please copy the diagram to the clipboard and paste in Word, Excel or Visio 
and print for there. Excel has very good multi-page printing support. 

30.4.2. Q: Startup of the software takes very long. 

We have reports from Sophos users that starting the software the first time takes quite long – apparently Sophos 
wants to take a detailed look. This problem goes away by itself. Otherwise you can whitelist the application in 
Sophos. 
 
Note: BowTieXP normally starts in a couple of seconds. 

30.4.3. Q: When opening BowTieXP, I get an error message about fonts. 

Please install the Microsoft European Union Expansion Font Update: 
http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=16083  

30.4.4. Q: I can no longer save documents as pdf if they have bowtie images in it 
(Office 2007) 

This is a known incompatibility with Office 2007 – the images generated by BowTieXP version 5.0 or earlier cannot 
be converted to pdf by the Office 2007 pdf add-in. 
 
This used to work okay but stopped working due to a change in Office, by means of Windows Update, and started in 
April 2012. Office was changed and now no longer can make pdfs of those documents. 
 
There are several resolutions, listed in order of preference: 

 Upgrade to Office 2010. Office 2010 does not have this problem. 

 Use an external PDF printer - free ones exist such as http://www.bullzip.com/. 

 Upgrade to BowTieXP v5.2 and redo the graphics.  

 
 
 

http://www.microsoft.com/en-us/download/details.aspx?displaylang=en&id=16083
http://www.bullzip.com/

